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About the Pittsburgh Science of Learning Center…
This document was produced as an outreach of the Pittsburgh Science of Learning Center (PSLC) in order to make the course development tools that have been developed in part through PSLC funding more accessible to researchers and practitioners outside of the center.  The purpose and mission of the Pittsburgh Science of Learning Center is studying what is referred to as robust learning in the context of real classrooms with rigorous and very highly controlled experiments.  From a theoretical perspective, we are leveraging theory from cognitive and social psychology and cognitive modeling to identify the instructional conditions that cause robust student learning and continued involvement in lifelong learning.  These tools are meant to be used in accordance with design principles introduced in the PSLC summer school lectures and further developed in PSLC publications and in the PSLC theory wiki, which can be accessed from the Learnlab.org website.  PSLC is advancing both basic research on learning in knowledge-rich settings and applied research by contributing to a scientific basis for the design and engineering of educational approaches that should have a broad and lasting effect on student achievement. 
These course materials were prepared in part as a recent effort within PSLC to build LearnLab India, as an extension of the PSLC LearnLab model that has been successful at the time of writing this in over 50 schools in the United States.  LearnLab India is a partnership between PSLC and the larger SCS community at Carnegie Mellon University with the Indian Institute for Information Technologies in Hyderabad.  LearnLab India will be housed at the three campuses of Rajiv Gandhi University of Knowledge Technologies (http://www.rgukt.in), which is an educational outreach to the rural youth of Andhra Pradesh, India.
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Introduction
In this SummerSchool package, we are offering a set of tools that allow efficient authoring of on-line instruction that is interactive and supports either individual or collaborative learning.   The accompanying video lecture series provides a foundation in learning science theory and instructional design principles, experimental methodology for user centered and data driven educational materials development, and basic instruction in using the tools.

All of these technologies can be used either for supporting individual learning or collaborative learning.  Prior work offers much evidence that although  the help students are capable of offering one another is not perfect, students benefit from the interactions they have with other students in problem solving situations in spite of the errors students make when helping each other (Gweon et al., 2006), and possibly even because of these errors (Piaget, 1985; De Lisi & Goldbeck, 1999; Grosse and Renkl, submitted).  
In addition to basic authoring tools, we also provide a framework referred to as Basilica that facilitates integrated components developed with individual tools into integrated environments that support instruction through multiple techniques.  One innovative type of environment that represents an emerging approach to supporting collaborative learning on-line is one that offers dynamic support for collaborative learning.  Specifically, with the resources provided in this tool set, we hope to facilitate harnessing the potential of state-of-the-art technology for automatically filtering collaborative learning discussions that we have developed in our previous work (Donmez et al., 2005; Rosé et al., 2008).  These capabilities can be used to trigger interventions that support students in helping each other learn together on an as needed basis (Gweon et al., 2006; Chaudhuri et al., 2009).  The interventions themselves can be implemented using tutorial dialogue and intelligent tutoring technology.  This concept has already proven effective  in some of our previous studies (Wang et al., 2007; Kumar et al., 2007).  
The tools we provide include :
· Cognitive Tutor Authoring Tools (CTAT) for implementation of structured problem solving environments, 
· TuTalk for implementation of instructional agents that can interact with students through natural language conversation, 
· TagHelper for automatic processing of conversational data in order to automatically identify important conversational events, and  

· SIDE for implementation of reporting interfaces for remote facilitators
Each tool in this package, provides a different type of functionality for either supporting monitoring on-line behavior, reporting analyses of that behavior, interacting with students through natural language, or providing structured  problem solving interfaces that provide hints and feedback.  
A final tool, which as mentioned above as Basilica, provides an infrastructure for combining these technologies into integrated instructional environments that provide a combination of facilities that can be creatively determined by content developers depending on the specific needs of the target students. Conceptually, this framework allows monitoring collaborative interactions as they unfold, which allows it to track behaviors such as argumentation, helping and explanation. Based on this analysis, instructional interventions, such as conversational agents implemented using TuTalk that are capable of engaging students in discussion on a variety of topics can be triggered in appropriate contexts. The purpose of this general purpose framework to support integration of a variety of instructional support technologies in a variety of ways and in a way that makes it easy to integrate these technologies with a wide range of collaborative environments. For example, we have recently integrated Basilica with the massively multi-player on-line environment called Second Life (Weusijana, Kumar, & Rosé, 2008).
An example of a collaboration environment implemented using Basilica, CTAT, and TuTalk is the MathTalk environment.  
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Figure 1. MathTalk environment for collaborative math problem solving.  Students interact with each other and with a conversational agent through a chat panel (on the left) and with each other through a shared problem solving space (on the right).

The interface in Figure 1 has two panels. On the left is a chat interface, which allows students to interact with each other as well as with conversational agents that are triggered at different occasions during the problem-solving session to offer support to the collaborating pairs. The panel on the right is the problem-solving interface, which allows students to work collaboratively on a given problem. In this case the interface in the right panel was built using the Cognitive Tutor Authoring Tools (CTAT), and the conversational agent that engages students in discussions about math concepts were implemented using TuTalk. The problem-solving panel has a problem layout and a hint button. The hint button triggers support built into the environment. The hint messages are displayed in the chat window. Both panels of the interface maintain a common state across both the participants at all times, creating a shared experience for the student dyad. All actions performed by a student in either of the panels are immediately communicated and reflected on the interface of the other student. 

Here is an example interaction between a student and one of the conversational agents that can participate in the chat:

Tutor: Another way to think of dividing by fractions is this: If I have 1 divided by 1/2, can I turn that into something divided by 1?. If I want to turn the denominator, which is 1/2, into 1, what do I need to do to it? 

Student 1: yep  


Tutor: Actually, you need to multiply by two. And If I multiply the denominator by 2, what do I have to do to the numerator? 

  


Student 1: 2 

  


Tutor: Right. So 1 divided by 1/2 is the same as 2 divided by 1. So that is one reason why the flip and multiply strategy for dividing by fractions works. If you multiply the denominator by something to turn it into 1, you have to multiply the top by the same value. So let's try another one. If I want to divide something by 2/3, what do I need to multiply the numerator and denominator by? 


Student 1: 3 

  


Tutor: Actually, it is 3/2. You should think about why it's 3/2. We'll talk about it more later.
Using These Materials…

These materials were developed to enable broad distribution of the content taught at the 2009 Pittsburgh Science of Learning Center Summerschool.  The summerschool itself was divided into plenary lectures that all students attended and four parallel tracks, for which each student typically attended all of the lectures within one track.  All of the lectures have been listed in the next section.  The tools for which this documentation focuses on are the specific focus of the Tutor Development Track (which focuses on the Cognitive Tutor Authoring Tools) and the Computer Supported Collaborative Learning Track (which focuses on TuTalk, TagHelper, SIDE, and Basilica).  

For students new to the learning sciences, it would be a good idea to begin by listening to the lectures listed under the Foundational Lectures in the next section.  These will give an overview of the theories and methodologies that will provide a foundation for the work you will do with the development tools. Next, you can listen to the introduction lectures for each of the tracks.  This will give you a sense of what each of those tracks are about.  Most likely your next step will then be to work through all the lectures in either or both of the Tutor Development Track or the Computer Supported Collaborative Learning track.  The other two tracks can be regarded as supplementary material from the standpoint of using the development tools.
Video Lectures

I. Foundational Lectures

· Studying and achieving robust learning with PSLC Resources

· Cognitive Task Analysis: Think Alouds & Difficulty Factors Assessment

· Educational Data Mining

· Issues in Transfer and Learning

· Cognitive Principles in Tutor Design

· Demo: Machine Learning and Simulated Students

· In Vivo Research to Test Hypotheses About Learning

· All you need to know about ITSs

II. In Vivo Experimentation Track

· In Vivo Experimentation Track Introduction

· Intro to in vivo studies
· Theoretical relevance
III. Tutor Development Track

· Tutor Development Track Introduction

· ACT-R / Building a cognitive model in Jess
· How to: Model tracing with a Jess cognitive model
· Demo: Create cognitive model with CTAT
· Demo: Create tutor GUI with Netbeans; Design & create GUI from think aloud
IV. Computer Supported Collaborative Learning Track
· Computer Supported Collaborative Learning Track Introduction
· Effective Instructional Conversations + TuTalk Instruction
· Integrated Collaborative Learning Environments with Dynamic Support
· TagHelper and SIDE
V. Educational DataMining Track
· Educational Data Mining Track Introduction

· Educational Data Mining Overview
· Learning from learning curves: Item Response Theory; Learning Factors Analysis
· Discovery with Models
TOOLS
· Cognitive Tutor Authoring Tools

· TuTalk

· TagHelper

· SIDE

1. Cognitive Tutor Authoring Tools (CTAT)
 1.1 Basic definition / About
The Cognitive Tutor Authoring Tools, or CTAT, is a tool suite that enables you to add learning by doing (i.e., active learning) to online courses.

The Cognitive Tutor Authoring Tools, or CTAT, is a tool suite that enables you to add learning by doing (i.e., active learning) to online courses. CTAT supports the creation of flexible tutors for both simple and complex problem solving, capable of supporting multiple strategies that students may draw on when solving tutor problems. CTAT tutors track students as they work through problems and provide context-sensitive, just-in-time help.

CTAT supports the creation of two types of tutors: example-tracing tutors, which can be created without programming but require problem-specific authoring, and cognitive tutors, which require AI programming to build a cognitive model of student problem solving but support tutoring across a range of problems. The two types of tutors are roughly behaviorally equivalent.

CTAT-based tutors can be created in Java or Flash. It is also possible to use CTAT to add tutoring to an existing simulator or problem-solving environment. 

CTAT tutors are seamlessly integrated with PSLC Data Shop. Tutors developed with CTAT write detailed logs of the student-tutor interactions, suited for teachers or researchers. This logging capability does not require any extra effort by tutor authors. The Data Shop provides support for detailed analysis of students' learning trajectories, based on the log data. For those who prefer to do logging only, CTAT provides a separate library with logging functions.

CTAT tutors can be delivered via OLI (Open Learning Initiative) courses, but a number of other delivery options are available, including standard web delivery.
1.2  Example Applications

 The politeness tutor
 A tutor that teaches the student about the underlying manner involved in the method of being polite. 
The student needs to choose from among options given in three different drop down boxes to complete a sentence.

The tutor gives an error/hint as and when the student chooses a wrong option, urging him forward to finally create the right sentence.
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Stoichiometry tutor
For stoichiometry, a sub-domain of chemistry that addresses the calculation of relationships between reactants and products in chemical reactions, the researchers required an interface that supported algebraic calculations. The Cognitive Tutor Authoring Tools were ideal for this task, providing enhanced problem solving through standard widgets, such as pull-down menus and text boxes.
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III)  Installation / Setup
[image: image80.jpg]
The CTAT installation includes a set of Flash components for authoring tutors and an HTML publishing template for publishing and configuring your tutors for the Web.
 Install CTAT Flash Components
NOTE: The Adobe Extension Manager (previously the Macromedia Extension Manager) is required to install the CTAT Flash components. If you don't see the Extension Manager in your list of installed programs, download and install it by choosing the appropriate version from the list below.
Flash CS3 use Extension Manager 1.8.
Flash 8 use Extension Manager 1.7.
Flash MX use Extension Manager 1.6.
a) Start the Extension Manager: 

· In Windows, select Adobe > Adobe Extension Manager from the Start menu. 

· In Mac OS X, double-click the Extension Manager icon in the Applications/Adobe Extension Manager folder. 

b) From the drop-down menu in the Extension Manager, select the version of Flash you will use to author tutors (e.g., Flash MX 2004, Flash CS3). 

c) Select File > Install Extension in the Extension Manager. 

d) Find and select the file CommComponents.mxp, located in your CTAT installation directory in the "Flash" folder, and press Install. 

e) When prompted with the Extension Disclaimer, press Accept. 

f) Confirm that the components have installed successfully. 

g) If you already have another version of the CTAT CommComponents installed, or another extension with the same name, the Extension Manager asks if you want to disable the one that’s already installed. Select Yes to replace the previous version with the new one. 

h) If you’re asked if you would like to replace one or more existing files, select Yes to All to accept the newest version of the components. 
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These components should now be available from the Components panel in the Flash IDE.

1.3  Basic Instructions
Building an example-tracing tutor for fraction addition
 Introduction

In this tutorial, you will use a completed student interface and CTAT's Behavior Recorder to author an Example-tracing Tutor for the fraction addition problem 1/4 + 1/6. You will author the tutor by demonstration, without programming. 

An Example-tracing Tutor is primarily composed of a student interface (by default, CTAT supports Java and Flash student interfaces created with our tools) and a Behavior Recorder graph (BRD file) that stores data on the current problem. Multiple BRDs (problems) are often used with a single student interface.

When authoring an Example-tracing Tutor, both the student interface and CTAT must be running, as they communicate with one another during the authoring process.

Run the student interface and CTAT

The first step in authoring an Example-tracing tutor is to open both the student interface and CTAT. For this, you have a choice between Java and Flash student interfaces: run either CTAT for Java or CTAT for Flash.

Step 1:  To open a Flash student interface for fraction addition:

Open a web browser window, and drag the fraction addition interface SWF listed above onto the web browser window. (Alternatively, if you have the Flash IDE, you can use it to open the SWF.)

Launch CTAT for Flash.
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Important note

Make sure to always use ‘Flash file action script 2.0’ only (And NOT  ‘Flash file action script 3.0’ ) to create a CTAT tutor using flash.
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Position the CTAT window and Flash student interface so that both windows are visible (see Figure 1 below).

[image: image8.png]


Note: If Flash presents a security warning, load the Global Security Settings panel, and add the location localhost to the list of allowed locations. This will enable the Flash student interface to communicate with CTAT. For detailed instructions, see Adobe's Flash Player TechNote.
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Figure 1. Positioning the Flash student interface for fraction addition and 'CTAT for Flash' side-by-side.

To open a Java student interface for fraction addition:

a) Launch CTAT for Java.

b) Select File > Open Student Interface. Locate and open the fraction addition interface CLASS file {CTAT}\Projects\FractionAdditionTutor\FractionAddition.class.

c) Position CTAT and the Java fraction addition interface so that both windows are visible (see Figure 2 below).
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Figure 2. Positioning the Java student interface for fraction addition and 'CTAT for Java' side-by-side.

When using 'CTAT for Flash', you must first ensure that the student interface has connected to the CTAT application. 

Step2:  Create a start state

Once your interface is running and connected to the Behavior Recorder, the next step is to create the initial problem state, or "start state". In your student interface, enter the two fractions 1/4 and 1/6 in the Given Fractions column.

To make this state the start state for the given problem, select Graph > Create Start State in the Behavior Recorder. When prompted for a start state name, enter 1-4+1-6, and click OK. You should now see your start state in the Behavior Recorder as a new node titled "1-4+1-6".

Step3:  Demonstrate Solutions

After creating a start state, demonstrate correct and alternate answers, as well as common errors, that students might make for this problem. The Behavior Recorder will record the demonstrated behavior in the form of a "behavior graph".

Ensure that CTAT's Author Mode is set to Demonstrate (see Figure 4). Then demonstrate a correct solution to the problem. The Behavior Recorder records each demonstrated step as an 'edge'—the line connecting two nodes—in its graph. In the graph, actions are represented by edges, while states are represented by nodes.
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Figure 4: Author Mode is set to Demonstrate.

You can demonstrate an alternative solution path—one which is correct but not preferred—by clicking on the start state node in the behavior graph, and demonstrating the solution steps for that path. For 1/4 +1/6, you might demonstrate a solution where the student multiplies the denominators to get a common denominator of 24. This solution is valid, but not preferred, as '24' is not the least common denominator. Preferred paths in the graph show thick lines for edges, while unpreferred paths show a thin line.

If you forget to include a solution step, click on the node that precedes that step (you'll see the student interface update to reflect the state of that node); then demonstrate your step. 

Tip: It is good practice to include a Done action at the end of each path in your behavior graph for two reasons: first, it is part of a cognitive skill to know when a problem is solved; second, when you create a curriculum consisting of a series of problems, the Done action, when accepted by the tutor, is a signal to present the next problem.

Step4:   Annotate solution steps

· Incorrect steps

Now you will demonstrate an incorrect solution to the problem, so that the tutor will be able to recognize this error when it is used by students. In general, any student input that is not recognized by the tutor is marked as incorrect; but by defining incorrect steps in the graph, the tutor will be able to provide a customized error feedback message for the specified input.

For the current simple problem, we will focus on the error (presumed to be common by students who have not yet mastered fraction addition) that students may attempt to add the two denominators of the fractions without converting them. For the current problem, they would enter 10 as either of the converted denominators, or the answer denominator, rather than a common denominator such as 12 or 24.

In the Behavior Recorder, first click on the start state; this will reset the interface to the start state. Next, type 10 in either of the fields for the denominator of the converted fraction. You should see a new link and state appear in the Behavior Graph.

By default, the Behavior Recorder assumes that any demonstrated solution step represents a correct step. When demonstrating incorrect actions, you therefore need to mark them explicitly as incorrect behavior. So right-click the edge that was created for an input of 10 and select Change Action Type > Incorrect Action (Bug) (see Figure 5). At the prompt to edit the error message, enter an error message that the student will see when they perform this action.

You can repeat this process for any incorrect action. Note that when a student performs an incorrect action, the student will not advance past the incorrect edge.
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Figure 5: Setting an incorrect action.
· Hint messages

You can attach hints to the links that represent correct actions. These hints will be displayed when the student requests a hint. Typically, multiple levels of hints are available for each action.

To define a hint message, click on a green action label displayed on an edge. From the pop-up context menu, select Edit Hint and Success Messages. Here you can define hints that will be shown to the student when they request a hint (see figure 5).
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Figure 6: Editing hints for link
· Skill labels

In this step you will add skill names (also known as production rule names or knowledge component labels) to the links in the behavior graph. The skill names correspond to the skills the student needs to perform in order to complete the problem. Later, if you create production rules for your tutor, you will create production rules that correspond to each skill name. When creating an Example-Tracing tutor, you do not need production rules, but the skill names will also be used for knowledge tracing.

To view and edit skills, you need to turn on the skill name display. This allows you to view the skill labels for each link. To do so, select Graph > Show Skill Labels from the CTAT menu. You should see some boxes titled "unnamed" appear on the graph. These boxes are your skill names.

To edit a skill name for an edge, right-click the skill name label for that edge and select Edit Skill Name (see figure 3). A dialog box titled "Edit skill name 'unnamed'" will appear. 
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Figure 7: The skill context menu

In the Edit Skill Name box, enter a name for your skill. Subsequent skill name dialogs will allow you to choose from a list of existing skills that you have defined. The "Skill set" field refers to the category of the production rule, such as "fraction addition".
· Save your changes

Select File > Save Graph (or use the keyboard shortcut Ctrl-S or Cmd-S) to save the behavior graph.
Step5:  Test your tutor

You can now test the tutor you have created. Set CTAT's Author Mode to Test Tutor (see Figure 8). To test your tutor from the beginning, click the start state in the behavior graph; then interact with the student interface.

To test from any other step in the problem, click the desired state in the behavior graph—the student interface will update to reflect the problem-solving state—and then interact with the student interface.
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Figure 8: Setting Author Mode to Test Tutor.

More information for creating better tutors using CTAT

You can generalize a complete graph to account for various problem-solving strategies, as well as a varieties of student input and step order. By generalizing, you're adding flexibility to a single graph structure to allow for a greater variety of student behavior.

Generalizing a behavior graph enables you to:

Specify a range or set of student input values to match on a given step;

Enable the tutor to perform some steps;

Constrain the order in which steps should be performed by the student.

a. Generalize

· Input Matching

In an Example-tracing Tutor, each action that a student performs is compared by the tutor against the set of potential actions described in the graph. Specifically, the tutor compares the student's 'selection' (widget), 'action' (interaction type), and 'input' (entered value) with those on the links of the graph. Whether this comparison is against all links in the graph or a specific subset of links depends on the graph's ordering constraints (see Section 2.3, “Ordering Constraints”).

You commonly edit student-input matching to match a wider range of student input (i.e, beyond the input you demonstrated), but you can also generalize matching on widget selection and action.

To edit student-input matching:
Click a link's label in the graph.

Select Edit Student Input Matching....
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Figure 2.1. Edit Student Input Matching dialog

When CTAT compares a student action with that defined on a link, it can do so precisely (an exact match), or by another method (eg, a regular expression, range, wildcard, or any value). The type of comparison is specified on each link in the graph. By default, the type of comparison is an 'exact' match. Other types of input matching can be specified for a link:

Exact Match

The default matching type. Requires that the student's selection, action, and input match exactly with that specified on the link.

Any Match

Any input value for the specified selection and action is considered a match.

Range Match

A value within the specified numeric range is considered a match. Includes the minimum and maximum values (eg, 0-100 would match inputs of 0, 2, 10.12, or 100).

Wildcard Match

A value that matches the wildcard pattern is considered a match. A wildcard * denotes any number of characters. Special characters such as {, \, or & should be avoided—for these, use a regular expression match. A wildcard expression can be used for selection, action, and/or input.

Example 1: "*_text" would match "_text", "this_text", or "123abc_text".

Example 2: "abc*xyz" would match "abcxyz", or "abc123xyz".

Regular Expression Match

A value that matches the regular expression is considered a match. Uses the Java regular expression engine. A regular expression can be used for selection, action, and/or input. Regular expression matching is the most powerful type of matching in CTAT.

Below are six examples that illustrate some of the regular expression conventions. For a complete reference and tutorial, see Sun's Java Regular Expression Lesson.

Example 1: The regular expression ^cat$ would match 'cat', but not 'a cat', 'cat one', or 'Cat'; the '^' character specifies beginning of a line, and '$' specifies end of a line.

Example 2: The regular expression animal. would match 'animals' or animale', but not 'animal' or 'animales'; the '.' character represents any single character.

Example 3: The regular expression [THK]im would match 'Tim', 'Him', or 'Kim', but not 'Jim'; any single character from the set of characters between the square brackets can be used in the match.

Example 4: The regular expression a{3} would match 'aaa' or 'aaaaaa' (it would match this twice), but not 'aa'; the number between the braces specifies the number of times the preceding character must occur to match.

Example 5: The regular expression .*hello would match 'hi hello', 'xhello', or 'hello'; the '*' character represents zero or more occurrences of the preceding character, and '.' represents any character.

Example 6: The regular expression \d\w\W would match '0z!' or '09@', but not 'b1+' or '4!!'; \d represents a digit (0-9), \w represents a word character (a-zA-Z_0-9), and \W represents a non-word character.

· Student- and Tool-Performed Actions

Steps in a behavior graph can be either student-performed (steps the student should perform) or tool-performed (steps that the tutor itself should perform). While a student-performed step specifies behavior the student should perform while using the tutor, a tool-performed step specifies an action that the tutor software will perform on the interface. Tool-performed steps are therefore powerful links that can be used to complete problem-solving steps, make changes to the student interface such as hiding or showing a widget, or perform other actions that you specify.

By default, demonstrated steps are stored in the behavior graph as correct steps that a student should perform when using the tutor. Steps such as these have an actor of student; that is, they are performed by the student. For steps where the tutor performs the step, the actor is the tool itself—a tool-performed action.

To specify a tool-performed action:
· Create a new link (optional) - while in Demonstrate mode, demonstrate a step in the student interface. For steps that cannot be demonstrated (e.g., hiding an interface widget), create a blank step in the graph by right-clicking a node in the graph and choosing Add Blank Step.

· Right-click (Windows) or Control+Click (Mac) on the action label of the link in the graph for which you'd like to specify a tool-performed action.

· Select Edit Student Input Matching.

· To the right of Actor, select Tutor (see Figure 2.2, “Specifying a tool-performed action”).
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Figure 2.2. Specifying a tool-performed action
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	Note

	
	Tool-performed actions can only be specified for links where the matching type is Exact Match.


Timing of tool-performed actions

A tool-performed action link in a graph is activated by the tutor whenever the state before the tool-performed link becomes the current state. In an ordered group of links, this process is intuitive: when the state preceding the tool-performed action link becomes the current state, the tool-performed action link is then activated. Slightly less intuitive is that this criterion—that a state with a single outgoing tutor-performed action link becomes the current state—applies for unordered groups of links as well (see “Ordering Constraints” below).

· Ordering Constraints

In a tutorable activity, you may want to specify which problem-solving steps come before other steps. In what order (if any) should the correct steps be completed by the student?

You can specify ordering constraints in CTAT by grouping steps, and specifying whether each group of steps can be completed in any order or sequential order. In addition, you can nest groups of steps. Using these basic tools, you can construct complex step-ordering constraints in your tutor.

The most basic example of an ordering constraint is when all steps in a problem or activity make up a single group of steps and that group is either ordered or unordered. When you create a new behavior graph, all steps are considered part of this group by default.

To view and edit ordering constraints
Display both the Group Editor and Group Creator windows by selecting them each from the menu Windows > Show Window.

[image: image19.png]3 0 ot e cmon, teles 2]
o Ty e et
B e I
& G Aoty oo, ot 0
H e o]
$EOmI Ty
S G Ao e e 0
H et
B el





Figure 2.3. The Group Editor and Group Creator windows

To create a group of steps (links):
· Select links from the behavior graph by holding CTRL or SHIFT and clicking each of the links (the arrows). (Alternatively, you can click and drag to draw a bounding box around the desired links.)

· In the Group Creator, click Create Group. Enter a name for your group.

· Traversal Count (optional)

· To add or remove links from a group:
· In the Group Editor, select the group to modify.

· Select links in the behavior graph to add or remove.

· In the Group Creator, click Add/Remove Links.

· In the Group Editor, you can also rename a group, delete a group, or choose whether its should be visualized in the behavior graph (Displayed On Graph).
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	Note

	
	Deleting a group places its links in the group above it; it does not delete steps from the behavior graph.


Ordered or Unordered

A group of steps is either ordered or unordered.
a) Ordered

The student has to perform the entire series of steps in the order they appear in the graph, from the start state node toward the final "done" step, for the problem-solving behavior to be considered correct.

b) Unordered

The student can perform the steps in any order for the behavior to be considered correct.

Ordered and unordered groups are visualized in the current behavior graph as rectangles and ovals, respectively.
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Figure 2.4. Behavior graph visualization of ordering constraints on groups of steps
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Note: Re-enterable

A group of steps is either "reenterable" or "not reenterable". "Reenterable" means that once the student starts working on a step in the group, the student may "leave" that group of steps to work on others, returning to it (reentering it) later. If a group is "not reenterable", the student must complete that group of steps once she starts it.

Another way of thinking about "not reenterable" is the phrase "you start, you finish": if you start working on this group of steps, you have to finish working on all if them before you can move on.

Next steps

Experiment with ordering constraints in your tutor, modifying the ordered/unordered and "reenterable" settings for each group.

Try combining ordering constraints with optional steps, formulas, and/or other types of student-input matching.

· Optional Steps and Minimum/Maximum Traversals

You can set a mimum and/or maximum number of a times a step should be performed by a student. CTAT refers to these events as "traversals"―that is, a successful match, by the tutor, on a student's action.

By default, the minimum and maximum traversals for a step are both set to "1": the student should perform the step once, but not more than once. You can use this feature to designate a step as optional by setting its minimum required traversals to "0".

Minimum and maximum traversals can be set on any correct or suboptimal-action step in an example-tracing tutor.

To set minimum and maximum traversals:
Click a link's action label in a behavior graph and select Set min/max traversals.

Modify the values and press Ok.

Test your tutor to see if the change has the desired effect on your tutor's behavior.

b. Annotate

· Hints

When a student requests a hint, the first (top-level) hint from the relevant link is displayed. A link can have multiple levels of hints, where each successive hint request by the student displays the next level of hint.
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	Tip

	
	The last hint is commonly a 'bottom-out' hint, a hint that informs the student of the correct answer so that they can continue. This approach, however, can facilitate students 'gaming' of the tutoring system by clicking through to the final hint for each step of the problem.
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	Note

	
	Only correct action links can have hints associated with them. If you switch the action type of a correct action link to one of the other types, you will be prompted to choose what to do with the existing hints—you can convert them to buggy (error) messages or remove them from the link.


To define hints for a correct action link:
· Click a correct action link in the Behavior Recorder.

· Select Edit Hint and Success Messages.

· Enter hints into the hint message text areas. Alternatively, you can copy hints from another link or rule by selecting the link or rule name from the combo boxes at the bottom of the Edit Hint and Success Messages dialog box.

· (Optional) Click Add Hint Level to define more than three levels of hints.

· Click Done.
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Figure 2.5. Edit Hint and Success Messages dialog

· Feedback

Feedback for a student action can be specified on all types of links. It is given after a student action is evaluated by the tutor.

For correct action links, feedback is a success message. For an incorrect or suboptimal action, feedback is an error ("buggy") message.

To define a success message:
· Click a correct action link in the Behavior Recorder.

· Select Edit Hint and Success Messages.

· Click More Options.

· Enter a success message in the Please Edit Success Message text area.

· (Optional) Choose whether or not the success message should be copied to links with a) the same selection/action/input, and/or b) the same production rule.

· Click Done.

To define a 'buggy' (error) message:
· Click an incorrect or suboptimal action link in the Behavior Recorder.

· Select Edit Bug Message.

· Enter a buggy (error) message in the text area of the dialog box. Alternatively, you can copy the buggy message from another link in the graph by selecting the link's description from the combo box.

· (Optional) Choose whether or not to copy the buggy message to all links with the same selection/action/input.

· Click OK.
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Figure 2.6. Edit buggy message dialog

· Skills

Each link on a behavior graph can have any number of skill labels associated with it. A skill label is a tag used to describe a piece of acquired knowledge that is associated with a step (link) in the graph. When applied consistently to steps in a problem, skill labels facilitate many types of analysis on the data generated by student use of the tutor. Such analysis based on knowledge components can be accomplished using the PSLC DataShop, a web application that facilitates learning science research through advanced reports and queries. Using the DataShop, you can easily produce learning curves and other reports from log data coded with knowledge component labels.

To collect this data for later analysis, logging must be turned on for the tutor. See Logging for instructions on configuring and enabling logging, including logging to the PSLC DataShop.
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	Note

	
	If Knowledge Component labels are not visible in the graph, click Graph > Show Skill Labels.


To associate a knowledge component with a step:
· Single-click the default skill ('unnamed') or another existing skill that you'd like to change.

· Select Edit Skill Name.

· In the Edit Skill Name dialog (figure below), enter a new skill name in the combo box or select an existing skill name from the drop-down menu.

· (Optional) Enter a new skill set name or select an existing one from the drop-down menu.

· Click OK.
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Figure 2.7. Edit Skill Name

To disassociate a knowledge component from a step:
· Single-click the knowledge component that you'd like to disassociate from the step.

· Select Delete Skill Name from Link. You'll be asked whether or not you'd like to delete the skill name.

· Click Yes to remove the skill name from the link; to leave the skill association as is, click No.

· With knowledge component labels applied, you can view a matrix of knowledge component usage by problem.

To view a knowledge component matrix:
· Select Windows > Skill Matrix.

· Using the Problems Organizer, select a subset of problems (or a single problem) by selecting course, unit, section, and problem name from the drop-down boxes.

· Click OK to view the skill matrix for the problems you've selected.

The Skill Matrix (pictured below) shows problem names vertically along the left-hand side of the table and skill names horizontally across the top. As skill names are often long, shortened identifiers are used (S1, S2 ...) to represent skills; these are defined below the table. The numbers in the table are counts of the number of times each skill appears in each problem.
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Figure 2.8. Skill Matrix (Knowledge Component Matrix)

C. Test

At any time during tutor authoring, you can test the behavior of your Example-tracing tutor. To do so, make sure the Tutor Type is set to Example-tracing Tutor and Author Mode is Test Tutor (see Figure 2.9, “Tutor Type and Author Mode for testing an Example-tracing Tutor” below).
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Figure 2.9. Tutor Type and Author Mode for testing an Example-tracing Tutor

In this mode, you can use the tutor, playing the role of a student attempting to solve a problem. Feedback, hints, and other messages will be enabled.

To jump to a state of the problem—partially solved, for example—click a node in the behavior graph. The student interface will update to reflect that state. You can then continue testing the tutor from that state.

To reset the problem, click on the start state of the behavior graph (the first node in the graph).

Changing the tutor's feedback and hint messages can be done while in Test Tutor mode. To demonstrate new behavior for the problem, you will need to switch to Demonstrate mode.
1.4 Additional Information
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Important note

Make sure to always use ‘Flash file action script 2.0’ only (And NOT  ‘Flash file action script 3.0’ ) to create a CTAT tutor using flash.
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TuTalk
2.1  Basic definition / About
The focus of our proposed work is to provide an infrastructure that will allow learning researchers to study dialogue in new ways and for educational technology researchers to quickly build dialogue based help systems for their tutoring systems. Most tutorial dialogue systems that to date have undergone successful evaluations (CIRCSIM, AutoTutor, WHY-Atlas, the Geometry Explanation Tutor) represent development efforts of many man-years. 
These systems were instrumental in pushing the technology forward and in proving that tutorial dialogue systems are feasible and useful in realistic educational contexts, although not always provably better on a pedagogical level than the more challenging alternatives to which they have been compared. 
We are now entering a new phase in which we as a research community must not only continue to improve the effectiveness of basic tutorial dialogue technology but also provide tools that support investigating the effective use of dialogue as a learning intervention as well as application of tutorial dialogue systems by those who are not dialogue system researchers. 
We propose to develop a community resource to address all three of these problems on a grand scale, building upon our prior work developing both basic dialogue technology and tools for rapid development of running dialogue systems.
2.2  Example Applications 
TuTalk can be used to create tutor-student dialogues that can assist the student in learning a concept in a subject, by creating a dialogue where in the tutor poses questions or makes a statement to teach the concept better to the student who may respond accordingly.

The following is an example of a dialogue between the tutor and the student, created to explain the concept of the ideal gas law.

In order to create the dialogue, it is advisable to follow the following procedure:

Create a paragraph that includes within it, all the concepts that you as a tutor would wish to convey to the student. For this it is advisable to use real life examples to explain the concept.

Based upon the paragraph, map out the student-tutor dialogue with the tutor questions/statements and the expected student responses.

For the example that we created, 

The following was the paragraph listing what the tutor wished to convey:

“Let us consider a hot air balloon with the air within it, being heated up by the burners. We know of the implication of increasing temperature upon the volume of an object while the pressure is kept constant. The Volume would increase. This is based upon the ideal gas law that states  “The state of an amount of gas is determined by its pressure(P), volume(V), and temperature(T)” and may be represented by PV=NRT.

Thus when the temperature within the balloon would increase, the volume would increase as well since the pressure is primarily constant, and this would lead to the balloon expanding.

Based on the same principle if we consider the effect of increased temperature on a closed container. Since the container is a closed one, the volume of the same remains constant. Thus an increase in temperature would result in an increase of the pressure of the gas within it.”

The final dialogue would look like this :

               (  NOTE : ‘Jenny’ is the default name of the student )

Tutor: Hi ! Welcome to this chemistry lesson ! Let us consider a hot air balloon with the air within it being heated up by burners. Would this lead to an increase or decrease in the volume of the Balloon ?

jenny: decrease

Tutor: No, it will increase. If that were true, then would hot air popcorn popping machines work correctly ?

jenny: no

Tutor: That's right.To elucidate further, as the temperature inside the popcorn making machine is increased, the volume of the popcorn increases(Since the temperature is constant). This would lead to the popcorn popping out. The underlying principle behind the above phenomenon is the ideal gas law. Have you heard of it before ?

jenny: yes

Tutor: Good. To elaborate it states ‘The state of an amount of gas is determined by its pressure(P), volume(V), and temperature(T)’ Thus when the temperature within the balloon would increase, the volume would increase as well since the pressure is primarily constant, and this would lead to the balloon expanding. Now consider the effect of increased temperature on the gas in a closed container. Would that lead to an increase or decrease in the pressure of the container?

jenny: increase

Tutor: That is correct. Since the container is a closed one, the volume of the same remains constant. Thus an increase in temperature would result in an increase of the pressure of the gas within it. This session is now finished. I have logged you out.. End of script file.

-------------

The following was the mapped out tutor-student dialogue:

Tutor : <Greeting>

Tutor (T) :  Let us consider a hot air balloon with the air within it being heated up by burners. Would this lead to an increase or decrease in the volume of the Balloon.

Student(S) :  Answer options :  Increase, decrease, anything else

If increase -( Tutor says “That’s correct”
If decrease ( Tutor says “No, The Volume would increase”

        As a sub goal to the response ‘decrease’ by the        student, 

Tutor: “If that were true, then would hot air popcorn popping machines work correctly ?”
Student : Yes, No, Anything else

If yes ( Tutor says “No they wouldn't. See, as the temperature inside the popcorn making machine is increased, the volume of the popcorn increases(Since the temperature is constant). This would lead to the popcorn popping out. However, according to what you said, the volume would not increase, but decrease and by that logic the popcorn would not pop out and the machine would not work.”

If no ( Tutor says “That's right. To elucidate further, as the temperature inside the popcorn making machine is increased, the volume of the popcorn increases(Since the temperature is constant). This would lead to the popcorn popping out.”

If Anything else ( Tutor says “Let me explain this.As the temperature inside the popcorn making machine is increased, the volume of the popcorn increases(Since the temperature is constant). This would lead to the popcorn popping out.”

T  : The underlying principle behind the above phenomenon is the ideal gas law. Have you heard of it before ?

S : Answer options : Yes, No , Anything else

If yes ( Tutor says “Good. To elaborate it states ‘The state of an amount of gas is determined by its pressure(P), volume(V), and temperature(T)’ “

If No ( Tutor says “The ideal gas law states ‘The state of an amount of gas is determined by its pressure(P), volume(V), and temperature(T)’ “.

T : Thus when the temperature within the balloon would increase, the volume would increase as well since the pressure is primarily constant, and this would lead to the balloon expanding.

T : Now consider the effect of increased temperature on the gas in a closed container. Would that lead to an increase or decrease in the pressure of the container?

S : Answer options : Increase, decrease, Anything else.

If increase ( Tutor says “That is correct. Since the container is a closed one, the volume of the same remains constant. Thus an increase in temperature would result in an increase of the pressure of the gas within it.”

If decrease ( Tutor says “That is not correct. The pressure would increase. Since the container is a closed one, the volume of the same remains constant. Thus an increase in temperature would result in an increase of the pressure of the gas within it.”

__________________________________________

2.3  Istallation / Setup

· Open the ‘TuTalkGUI’ Folder provided

· Select the MSDos atch file ‘TuTalkGUI-RunMe ‘

· The main TuTalk GUI window opens.

2.4  Basic Instructions
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Figure 1  TuTalk Front panel
Looking at the view of the TuTalk GUI that you get when you first start it up will help you think about the process of authoring a dialogue.  You’ll see that there are three tabs on the tabbed interface, namely the Author panel, the Preview panel, and the Test Dialogue panel.  In line with this, the typical authoring process consists of building a representation of how your authored dialogue will operate, possibly checking that flow on the Preview panel and then running it so that you can actually interact with the running dialogue that results on the Test Dialogue panel.

Here we will step through the process of doing the authoring.  As you interact with the TuTalk GUI, the result of your authoring actions will be written to a file referred to as a Script.  So to start the process off, you have to open a new script file.

Step 1: Start a new script
[image: image34.jpg]Open script e
Delte Scrpt Fle

New Template. -
Open Template: 7

Save Template
Delete Template

‘Append Conversation
Laad Canversation
Insert Sentence

Insert StepiPair

Mergs To SubTemplate
View HL

Concept Manager

Import XML Fle:
Export XML Fle
Compleand Test >




Figure 2 Opening a new script file

To start a new script file, click on the Author menu as you see displayed in Figure 2.  Then select New Script File.  
You can think of Script Files as being sort of like File Folders where you might keep notes for teaching one lesson.  Within that folder, you will keep several sheets of paper, which each contain instructions for teaching one main idea that is part of that lesson, keeping in mind that all of the ideas that are part of a lesson fit together somehow.  
Some of those ideas will consist of multiple smaller “sub-ideas”.  And other sheets of paper within the folder may expand a single one of those smaller ideas into an even more fine-grained break down of smaller ideas.  We will refer to those sheets of paper as Templates.  
And we’ll refer to the name of the main idea that the template specifies how to teach as the goal name.  Note that there may be multiple templates with the same goal name within the same script file because often there is more than one way to teach an idea.

Step 2: Start a new template
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Figure 3  New Template window

After you have started a script file, you will start to fill it with templates, recalling that each template is like a sheet of paper in your script file, which is like a file folder.  Once you have completed step 1 above to create a new script file,  a window named “New Template” will automatically appear, as you see in Figure 3.  
Click the button labeled “New” next to the pulldown menu under “Please select goal name:”.  You should name this initial goal “start”, ensuring that you have used a lowercase s in order to avoid runtime errors later.  
Thus, the template that specifies how to satisfy the start goal, which represents the lesson corresponding to the script file you just created, is the first one you will start to construct.
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Figure 4  Beginning to add content to a Template

After you click OK, a new New Template window will appear, as displayed in Figure 4. 
Each template is composed  of a series of steps.  You could think of these as steps in a process that are required to achieve a goal.  For example, if you were ordering in a restaurant, you might first order an entrée, then specify side dishes, and finally order your drink.  
You’ll see three options listed in Figure 4, but mainly two of them will be relevant for these simple instructions, namely Insert Sentence and Insert Step/Pair.  
Insert Sentence is used when a step in the process can be accomplished just by outputting some text, where no student response is required.  Insert Step/Pair is used when the tutor will utter something that has a response associated with it.  We will begin with the Insert Step/Pair option.

Step 3: Insert an Initiation/Response Pair
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Figure 5  Interface for specifying a template, which is a series of elements which are either Sentences or Initiation/Response pairs

In the New Template window displayed in Figure 4, select Insert Step/Pair and click OK.  Then the interface displayed in Figure 5 will appear.  This is the interface for specifying the series of steps contained within the corresponding template.  Note that the template has been initialized with a single Initiation/Response pair.  You can type text into the initiation and response boxes.

The initiation is the tutor’s turn and the response is the student’s turn.  Note that several possible responses can be associated with a single initiation.  This is desirable since a student may respond in many different ways.  For example, if the tutor asks whether the student has heard of a concept before, the student may respond with “yes”, “no”, or any of a range of unexpected ways, such as “my tooth hurts!”.  Each of these responses can be associated with a different tutor reaction.  We’ll describe how to author the tutor’s reaction in Step 7.

Step 4: Creating a Concept

For any response, there may be multiple ways the student may express the same idea.  Furthermore, there may be subsequent tutor initiations that may be similar in terms of the range of expected responses.  Because of this, an additional layer of representation referred to as a Concept is introduced here.  If the range of ways of expressing an idea is represented with a Concept, then in subsequent Initiation/Response pairs the same Concept can be reused.
A concept is an idea that a student or tutor might express.  A Concept is defined as a list of phrases, each of which is a way of expressing a concept.  Phrases can be expressed in a very “sketchy” way.  For responses, they are used as patterns that match against what students type.  
So it’s good to keep them somewhat underspecified.  For example, if you think a student might say something like “My toe is really big”, and you want to distinguish that from when students say “My toe is really small”, then maybe you really only have to use a concept for Big and a concept for Small to distinguish between these two responses.  
Or, if you want to distinguish between when students say their toe is big from places where students say their fingers are too small, you could have a toe-big concept where phrases would include “big toe” and “toe big” and a finger-small concept where the phrases might be “finger small” and “small finger”.  “toe big” will match against “My toe is big” or even “My toes are big”.  Expressing concepts with general patterns is more efficient that listing many very specific phrasings that differ in irrelevant ways.  
In order to make concepts as reusable as possible, the set of phrases associated with a concept should all mean the same thing in addition to being responses that the tutor would treat the same way in terms of deciding how to respond.  So for example, if the tutor asks “Do you know what 2 + 2 is?”, two different expected responses might be ways of saying “4” and ways of saying “yes”.  Since these don’t mean the same thing, there should be two different concepts, one for each of these types of responses.  But you may author the response associated with each concept the same way so that the behavior of the tutor in response to either of these ideas can be the same.
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Figure 6  Creating a new concept

For both the initiation and each response, you need to fill in a concept.  If you simply type text into the text box, a corresponding concept with a meaningless name like “Concept-54” will be created.  A better way of filling in a concept is to use the menu options you can get to by right clicking near “Select Concept”, which is to the right of the Initiation and each response in Figure 5.  You’ll see three options, namely, Pick Concept, Remove Concept, and New Concept.  If you want to reuse a previously defined concept, you can select Pick Concept, which will then lead you to a set of menu options including all previously defined concepts.  Remove Concept will take a previously selected or created concept off the current initiation or response, but note that it will not delete it.  To actually delete a created concept from the script file, see Step 6 below. Select New Concept in order to create a new concept.
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Figure 7  Specifying a new concept

After you have selected New Concept from the menu, the interface appearing in Figure 7 will appear.  Here you can enter the name of the concept and one representative phrasing.  Since this is the phrase that will show up on the interface, it’s a good idea to pick something that will remind you of the full meaning of the concept since some of your phrasings will be more sketchy.  Note that the Concept Name should not contain any spaces or characters other than letters, numbers, dashes, or underscore characters.
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Figure 8  Elaborating the definition of a Concept

Once you have created a concept, you can elaborate its definition by adding additional phrasings.  You start this process by right clicking in the text box corresponding to the concept.  You can see the resulting menu in Figure 8.  If you select Expand, you can see all the alternative phrasings currently in the Concept.  If you select Colapse, you can retract that list of alternative phrasings so that only the initial one is showing.  To add a new phrasing, select Add Phrase.
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Figure 9 Continuing to add new phrasings

When you click in one of the alternative phrasing text boxes, you’ll get a slightly different menu than when you click in the main text box associated with the concept, as you see in Figure 9.  You’ll see three options, namely Add, Edit, and Delete.  Add is for adding an additional phrasing.  Edit allows you the modify a phrasing that is already in the list.  And delete is used to remove an alternative phrasing from the list.  You won’t be able to remove the initial one.  

The process of creating a concept that represents the tutor’s initiation is the same as for creating a concept for a response.  Note that as mentioned above you may have multiple response concepts for a single initiation, and a template may have many such initiation/response pairs.  So the next step is to elaborate the template definition in this way.

Step 5: Elaborating the Template
On the left of the template authoring panel is a bank of buttons that allow you to either add or delete responses in the current Initiation/Response pair or add or delete subsequent Initiation/Response pairs, displayed in Figure 10.
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Figure 10  Buttons for elaborating the template
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Figure 11  An initiation/response pair with multiple responses, many of which include multiple phrasings
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Figure 12  An initiation/response pair where previously defined concepts for the response have been used.

In the same template, you may include additional Initiation/response pairs.  You add these using the Add Step button, and can subsequently remove one by clicking on the Delete step button closest to it.  For the current template, for example, you may follow the initiation/response pair in Figure 11 with the one in Figure 12.  For each initiation/response pairs you will create concepts as specified in Step 4.  Note that in the initiation/response pair in Figure 12, the concepts defined for the initiation/response pair in Figure 11 have been reused by selecting the Pick Concept option after right clicking near the Select Concept label to the right of the corresponding text box.

Step 6: Managing Concepts with the Concept Manager

If you want to modify or delete a previously created concept, or even create a new one, you can do so at any time using the Concept Manager.  From there, you can also take inventory of all of the concepts you have created up until that point.  You can get to the Concept Manager from the same Author Menu you used to start the authoring process.  This time select Concept Manager as you see in Figure 13.
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Figure 13  Navigating to the Concept Manager through the Author menu.
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Figure 14  The Concept Manager

Figure 14 displays the Concept Manager interface.  If you want to create a new concept, click on the New Concept button.  Any operation you want to perform on an existing concept will be done by first selecting that concept from the menu you see on the left side of the Concept Manager.  If you want to then change the name of the selected concept, you can click on the Rename Concept button.  To delete the selected concept, click on Delete Concept.  Once a concept is selected, you will see the phrases associated with that concept to the right.  You can edit that list using the Add Phrase, Edit Phrase, and Delete Phrase buttons.  To close the Concept Manager, click on the Close button.

Step 7: Authoring the Tutor’s Reaction to a Response

Frequently if a student offers the expected response to a tutor’s initiation, no response will be authored.  Instead, the dialogue will just proceed to the next step.  However, if a specific response is desired, there are two main responses that can be offered before the dialogue proceeds on to the next step.  The first of those is a very simple response consisting just of a simple text.  That is referred to as a Say.  To include that sort of response, right click near Select Goals near the associated response as you see in Figure 15, and select Add Say.  After you do that, a text box will appear where you can type in the text you would want the tutor to say.

[image: image47.jpg]Select Concept;

Select Goals

Pick Concept
Remave Concept
New Cancept

Say:  concept_40
Okay, 50 et's getstarted.

Pick Goal
Remave Goal

Select Concept: franticp:  New Goal

Select Goals Select Sy s

Sayi  concept 40 Remove Say

Okay, 50 et's get started,




Figure 15  Adding a “Say” reaction associated with a response.

If a more elaborate reaction is desired, consisting of one or more initiation/response pairs, then instead of Selecting Add Say, you should select New Goal to create a goal associated with a new reaction you would like to author.  Alternatively, if there is already one authored, you could select a goal using Pick Goal from a list of goals that already have templates authored for them.
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Figure 16  Selecting New Goal so that a new template can then be authored.
If you choose to create a new goal, then you will have the option of either putting the current template on hold so you can go ahead and author a template corresponding to the new goal, or you can wait.  The interface displayed in Figure 17 will appear after you have selected New Goal, as you see in Figure 16.
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Figure 17  Interface for choosing whether to create a new template associated with a goal you have just created (Select Yes) or to wait and continue with the current template (Select No).
If you choose to go ahead and author the subdialogue now(By clicking ‘Yes’ above), you will then be creating a new template, just as you began doing in Step 2, and thus you will end up triggering the same interface as was displayed above in Figure 4.  From there, the process is the same as what we have just covered for Steps 2 through the current one, except that you will be authoring a template associated with a response to one of the steps in the template you had been authoring.  In this way you can author and navigate the hierarchical structure of the dialogue script.

If you choose to not go ahead and author the subdialogue now(By clicking ‘No’ above), you will remain in the same tutor page as before.The goal will be created, but the template for the goal will not be defined until you go to the goal (By clicking on ‘Go’ beside the goal name)and select ‘New template’ from the ‘Author’ tab. Now you will end up triggering the same interface as was displayed above in Figure 4.  From there, the process is the same as what we have just covered for Steps 2 through the current one, except that you will be authoring a template associated with a response to one of the steps in the template you had been authoring.  In this way you can author and navigate the hierarchical structure of the dialogue script.
As you are authoring the hierarchical structure of the script file, it will often be necessary to navigate from one template to another one that is triggered by a response to one of the initiations in that template.  And once there, it will eventually be necessary to navigate back.  This is accomplished in TuTalk with a browser-like interaction.  Clicking on the Go button next to a 

response will take you to a template authored for the associated sub-goal. 

There is also the advised option of creating multiple templates for a single sub-goal. This can be achieved by clicking on Author > New Template.
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Figure 18 clicking on New Template in this case creates a new template within a sub-goal.

This creates an alternate template that may be accessed by the user when (s)he accesses the sub-goal through a certain response. 

The reason why it's useful to have multiple templates for the same
sub-goal is that 

a) It is possible then to generate a wider variety of
dialogues.  In some cases, a student may go through a dialogue more
than once - especially for foreign language classes where a student
might be practicing having a conversation in a particular scenario,
or for another type of course where the same issue may come up
multiple times, maybe over multiple sessions related to the same
general topic.  So then the dialogue does not seem like just
a repeat. 

b) Moreover, if there's more variation in the responses that the student gets from the tutor in this way, it also makes the agent seem
more realistic.

c) Another possible use is that it allows the
agent to try to teach the same idea in multiple ways, in case the first
way does not help the student much, maybe approaching the same idea from a different direction would work.

 Once in the sub-goal window, you can navigate back using the Back button as displayed in figure 18.  If you choose to create the sub dialogue when you select New Goal, and then navigate back after having completed that, you will see something like Figure 19, which shows a goal associated with the decrease response.
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Figure 19  In this interface we see the Back Button, which is used to navigate back to the template you were authoring when you clicked Go to get to the current template.
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Figure 18  An initiation/response pair where one response is associated with a subgoal, specifically the decrease response is associated with the subgoal alternate.
Step 8: Previewing an Authored Dialogue
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Figure 19  The Preview panel can be used to examine different paths through the authored dialogue script.

Figure 20 displays the Preview panel, which can be used to review what you have authored so far without having to compile first.  It can be faster to get a sense for how the dialogue flows this way because you can manipulate what responses are triggered at different choice points without starting the dialogue all over again.  On the left you can see a representation of the whole script, including all of the choice points.  At each choice point, a single choice has been made.  By default, the first response associated with every initiation is selected.  But you can change that by double clicking on a different response.  The dialogue displayed at the right will show how the dialogue will flow given all of the choices that are selected in the representation of the script at the left.

Step 9: Compiling and Testing a Dialogue

Testing frequently throughout the authoring process is a good practice, especially when you are a new author since sometimes it is difficult to keep the flow of the dialogue you have authored in your head.  The first thing to do when you want to test the running dialogue is to compile the script into XML.  You will do this by going to the Author menu and selecting Compile and Test -> From GUI as displayed in Figure 21.
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Figure 20
 In order to run your authored script, first select Compile and Test -> From GUI from the Author menu.

After you have started the compile from GUI process, you will see the interface displayed in Figure 22, which shows the XML representation for your script.
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  Figure 21 XML representation of an authored script

Once the XML representation of the script is showing, as in figure 22, click on Test to bring up the test interface you see in Figure 23.  You can then interact with the running dialogue by typing into the text input box at the bottom of the interface.  That text box is displayed in grey in Figure 23.
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Figure 22 The interface for interacting with the running, authored dialogue scripts.
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Notes:

a) Whenever a response box is open and the tutor saved, a corresponding concept is attached to the response, even if it may be empty (No text). To avoid this, check the response box, if you don’t intend to use it, and click delete box before saving the tutor. If the tutor has already been saved and the extraneous concepts created, the concepts can be deleted from the concept manager.

b) Avoid using spaces while naming a starting goal, subgoal or concept (The underscore ’ _ ’ may be used instead).

c) Try avoiding the usage of the word ‘Start’ (With a capital ‘S’ ) as the name of the starting goal of your tutor to avoid run time errors.

3. Tag Helper

3.1 Basic Definition/ About

Earlier, the overview of this document described how the Basilica framework integrates Actors (which offer interactive instruction to students) and Filters (which monitor behavior and can be used to implement triggers for Actors).  TagHelper tools is designed to enable developers to develop Filters than can “listen in” on student conversations or other natural language input from students, such as short answers to open ended questions.  Thus, rather than being a tool for authoring interventions that offer interactive instruction themselves, as CTAT and TuTalk do, TagHelper tools is a tool for monitoring student behavior in search of key events that can be used to assess how closely it does or does not conform to expected standards, so that it is possible to offer educational interventions to students on an as-needed basis, rather than treating all students and all student groups as though they have identical needs.    
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Figure 23 This figure illustrates how TagHelper tools is able to classify instances of student behavior, such as individual chat contributions in a collaborative learning environment

Figure 1 illustrates how Filters built using TagHelper tools can be used to dynamically build a map of student behavior as it unfolds in real time.  Key events detected within this scope can then be used to trigger needed interventions.  One built in advantage of building environments using this design is that if a mistake is made in offering an intervention that results in a negative change in student behavior, this can be detected in the ongoing monitoring of student behavior, and compensated for using subsequent interventions.  In this way, TagHelper tools can play an important role in the development of self-adjusting dynamic instructional environments.
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Figure 24 This figure illustrates the process of building a Filter using TagHelper tools.  

Figure 2 briefly illustrates how TagHelper is used.  More details about use are described below in the step by step instructions.  In short, TagHelper tools uses machine learning and basic text extraction technology from the field of computational linguistics to detect patterns in student behavior, which may include language and other click data collected as students interact with an environment’s interface.  We refer to the process of identifying those rules as learning or training a model.  And we refer to the learned patterns as the model itself.  When that model is said to be applied to unlabeled instances of behavior, it can look for those patterns and thus make what can be thought of as an “educated guess” about the category that should be assigned to those instances.  We think of it as an educated guess because although the learning algorithms within TagHelper tools are designed to identify rules that have the highest likelihood of success based on the information that was available during the training process, they can make mistakes, especially on data that is very different in some way from the set of instances provided during training.

3.2 Example Applications

As an example of where TagHelper Tools has been used in an application, we refer to a collaborative environment in which students work together on a collaborative design task, and conversational agents implemented using TuTalk are triggered based on the topic of the discussion in order to encourage students to stop and reflect more deeply about the concepts they bring into the conversation.  Table 1 displays one such interaction between a pair of students and a tutor agent collected during a recent classroom study using VMT-Basilica where the task was for students to design a power plant.  

Table 1 Example Interaction from a classroom study where students worked together on a collaborative design task

	B6
	so i think the best thing to go with first is to increase the pressure entering the connector

	Tutor
	You might want to review what you saw earlier in the sensitivity analysis investigating the effect of changing P-max on steam quality and efficiency, from the top half of page 13 in your book.

	Tutor
	type: HELP WITH CHANGEPMAX if you want to discuss it with me.

	B1
	help with changepmax

	Tutor
	Remember the sensitivity analysis you have completed where you manipulated P-Max and observed it's effect on the efficiency of the cycle. You can refer to the figure that I have pasted onto your whiteboard for your convenience.  Having seen how changing P-Max, the Maximum Pressure at the Heater Inlet, effects efficiency and Steam, do you think as a general principle the Maximum pressure should be increased ?

	B6
	Yes

	Tutor
	So the Efficiency of a Cycle increases by increasing the maximum pressure of the cycle. In addition to the effect on efficiency, what happens to the steam quality at the turbine exit if you increase the maximum pressure of the cycle ?

	B6
	Decreases

	Tutor
	So let's think for a minute about these competing effects: Increasing P-Max makes the efficiency better but the steam quality degrades. Is the steam quality at the turbine exit acceptable at the maximum allowable pressure within safety limits?

	B6
	No

	Tutor
	How does having poor steam quality at the turbine exit effect the turbine blades ?

	B6
	makes up wear down

	Tutor
	The steam condenses on the turbine blades and leads to wear and tear. What is the minimal quality of steam that we want to maintain so that the damage to the turbine is not significant ?

	B6
	0.85

	Tutor
	Steam quality should be maintained above 0.85 to avoid any damage to turbines blades during operation. So we need to balance these concerns by increasing the maximum pressure, but not enough that the quality of the steam drops below the minimum value (0.85). Are there other limitations on increasing the maximum pressure at the heater inlet ?

	B6
	no?

	Tutor
	Can the devices and pipes in the cycle stand if we keep on increasing the pressure ?

	B6
	20000kPa

	Tutor
	Beyond a particular pressure, the pipes and devices in a cycle become unsafe at risk for accident. The maximum pressure at heater inlet should be within safety constraints of the material used. 

	B1
	so to what value do you want to change the pressure at s1?

	B1
	do we want to keep X of s3 above or below .85?

	B6
	Above

	B1
	so, if we want to increase p1 while keeping X3 above 0.85, what about 8500kpa as p1?


Notice in the conversation above that the tutor’s contributions are responsive to those of the students. Filters implemented using TagHelper tools are meant to identify meaningful patterns within the stream of activity produced by students as they interact with and through a client collaborative learning environment.  
In the interaction displayed above, TagHelper detects that students are discussing manipulating the maximum pressure of the thermodynamic cycle that forms the foundation for their power plan design.  The student turn that triggered this detected topic is the first student turn.  We then see in the next turn the initial prompt where the tutor invites the students to ask for help on the topic of changing the maximum pressure of the cycle.  In our experience, students are much more receptive to instruction from a tutor agent in the midst of their collaboration when it is well times with respect to their goals, and when they are given the option to choose to have that interaction or not. 
 In this case, notice that the tutor agent first suggests that the student reflect on a topic and then provides instructions for how the students can ask for that help.  The students are able to continue what they were talking about until they are ready to ask for the tutor’s help.  In this case, they ask right away.  This approach to tutor involvement was implemented using two separate filters and two separate actors within the Basilica paradigm.  First, a filter detects that the students are discussing a topic related to help the agent can offer.  Then an associated agent offers the help.  A second, independent filter waits for the student request.  
Finally, an actor in the form of a TuTalk agent delivers the interactive instruction.  Notice how the students build on the ideas discussed with the tutor after the interaction with the tutor agent ends.  In the final turns of the interaction after the tutor agent has completed its intervention, we see how the students reflect on the implications the discussion has for their design.
3.3 Installation/Setup

Start TagHelper tools by double clicking on the portal.bat icon in your TagHelperTools2 folder, which you will get when you unzip the archive. You will then see the following tool pallet :
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Figure 25  This figure displays the starting interface for TagHelper tools
The idea is that you will train a prediction model on your coded data and then apply that model to uncoded data.  To start that process, as we will discuss in the next section, click on Train New Models.
3.4 Basic Instructions
Step 1: Preparing the Data
The first step in using TagHelper tools is preparing your data.  Because we have observed the popular usage of Microsoft Excel as an environment in which researchers commonly do their corpus analysis work, we have adopted that as our standard file format. Note that the version of TagHelper that is publicly available at the time of writing this article is designed to work with pre-segmented English, German, or Chinese texts, although additional licensing is required for enabling the Chinese functionality.  We plan to add other languages as potential users express interest. In this section we illustrate the process by which an analyst can use TagHelper for an analysis task. Setting up the data for analysis is simple. As in the example in Figure 26 below, analysts can prepare their data by reading the text segments into a single column in an Excel worksheet. That column should be labeled “text”. Each column to its left will be treated as a dimension in the coding scheme. Additional columns to the right are treated as extra features that can be used in the predictive model, such as the context based features evaluated above. Wherever a “?” appears, the corresponding text will be treated as uncoded on the associated dimension, which TagHelper tools will code using a model trained from the coded examples. Any other value appearing in that column will be treated as a specific code. And the associated example will be treated as an example representing that code.
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Figure 26  Example file formatted for use in TagHelper tools

Step 2: Loading the Data

After the data has been prepared, it can then be loaded into TagHelper tools.  First, start up TagHelper by clicking on Portal.bat as we discussed in the Installation section.  Then click on the Train New Models button.  You will then see the Create File List interface that is displayed in Figure 27 below.  To add a file to the list, Click on Add a file.  That will bring up the file menu interface you see displayed in the same figure.  You can then navigate to the desired file, click on it, and then click Okay.  For this walk through, we will be using SimpleExample.xls, which is found in the sample_data directory that comes with TagHelper tools.
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Figure 27  This figure illustrates how to load a file in TagHelper tools
Step 3: Running a Simple Experiment

Once the data is prepared and loaded into TagHelper, a number of customizations can be performed that may affect the classification performance. The analyst can experiment with these different options to find a setting that works well with their data.  But simple experiments can be run keeping the default settings.  In that case, simply click on the Go! button that is displayed at the bottom of the Create File List interface.  What will happen when you do this is that a model will be trained using all of the coded examples from the data set that will then be used to apply labels to any uncoded examples in that set.  With the coded data, it will also use a technique referred to as cross-validation to estimate the level of performance that can be expected of the trained model on unseen data.    
Step 4: Running a More Complex Experiment
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Figure 28  Close up of Create File List interface
If you click on the >> Options button, you will have the opportunity to modify TagHelper’s default settings for feature extraction, feature selection, machine learning, and optimization techniques.

TagHelper tools is an application that makes use of the functionality provided by the Weka toolkit (Witten & Frank, 2005). In order to use the customizations available in TagHelper tools purposefully it is important to understand that machine learning algorithms induce rules based on patterns found in structured data representations. Internally, each row of the input file provided to TagHelper will be converted into what is known as an instance inside of Weka. An instance is a single data point. It is composed of a list of attribute-value pairs. An analyst has two types of options in customizing the behavior of TagHelper. One is to manipulate the structured representation of the text, and the other is to manipulate the selection of the machine learning algorithm. These two choices are not entirely independent of one another. An insightful machine learning practitioner will think about how the representation of their data will interact with the properties of the algorithm they select. Interested readers are encouraged to read Witten and Frank’s (2005) book, which provides a comprehensive introduction to the practical side of the field of machine learning.  Interested readers may also contact the first author about enrolling in a distance course that provides both conceptual instruction as well as mentoring on the process of using this technology in ones own work.
The first customization that analysts may manipulate in TagHelper is the selection of the machine learning algorithm that will be used. Dozens of options are made available through the Weka toolkit, but some are more commonly used than others. The three options that are most recommended to analysts starting out with machine learning are Naïve Bayes (NB), which is a probabilistic model, SMO, which is Weka’s implementation of Support Vector Machines, and J48, which is one of Weka’s implementations of a Decision Tree (DT) learner. SMO is considered state-of-the-art for text classification, so we expect that analysts will frequently find that to be the best choice.   The algorithm can be selected by clicking on the Choose button at the top left corner of the Options interface displayed in Figure 29.
The remaining customization options affect the design of the attribute space. The standard attribute space is set up with one binary attribute per unique word in the corpus such that if that word occurs in a text, its corresponding attribute will get a value of 1, otherwise it will get a value of 0. Other features may be added, or the baseline features may be modified or paired down, in order to bias the algorithms to learn rules that are more valid or conceptually more closely related to the definitions of the target categories.
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Figure 29  Interface for customizing TagHelper's settings for feature extraction, feature selection, machine learning, and optimization
Here is a description of the options you have readily available to you:
·  Punctuation. Punctuation may be stripped out of the attribute space, or it can be used as a feature. Sometimes punctuation can be a useful predictor. For example, punctuation can be a proxy for the mood of a text, distinguishing questions like “you think the answer is that Michael does not like math?” from statements like “you think the answer is that Michael does not like math.” It can also be a marker of uncertainty. Furthermore, the inclusion of a comma might mark that a contribution is relatively more elaborated than one without a comma.

· Unigrams and bigrams. A unigram is a single word, and a bigram is a pair of words that appear next to one another. Unigrams are the most typical type of text feature. Bigrams may carry more information. They capture certain lexical distinctions such as the difference in meaning of the word internal between “internal attribution” and “internal turmoil”.

· POS bigrams. Part-of-speech bigrams are similar to the word bigrams discussed above except that instead of pairs of words, they are pairs of grammatical categories. They can be used as proxies for aspects of syntactic structure. Thus, they may be able to capture some stylistic information such as the distinction between “the answer, which is …” vs “which is the answer”.

· Line length. Often times lengthy contributions in chat data contain elaborated explanations, which are important to detect in learning science research. Thus, length of contribution can sometimes serve as a proxy for depth or level of detail.

· Contains non-stop word. This flag can be a predictor of whether a conversational contribution is contentful or not, which can be useful when processing chat data rather than newsgroup style data. For example, making a distinction between contributions like “ok sure” versus “the attribution is internal and stable”. Often the categories that are appropriate for non-contentful contributions are distinct from those that apply to contentful ones. So this can be a useful distinguishing characteristic.

· Stemming. Stemming is a technique for removing inflection from words in order to allow some forms of generalization across lexical items, for example the words stable, stability, and stabilization all have the same lexical root.

· Rare words. Removing rarely occurring features is a simple way of stripping off features that are not likely to contribute to useful generalizations. This keeps the size of the feature space down, which aids in effective rule learning.
· After you are happy with your selections, you can click the OK button, which will return you to the interface where you can click on the Go! button.               
Step 5: Evaluating the Results of an Experiment

Once you have run an experiment, you can find the output in the OUTPUT folder.  There will be a text file named Eval_[name of coding dimension]_[name of input file].txt.  This is a performance report.  There will also be a file named [name of input file]_OUTPUT.xls. This is the coded output.

Sometimes you will run a whole series of experiments, and in that case, it will be useful to distinguish the files generated from the different experimental rounds.  You can distinguish the files by inserting some distinguishing text for each round in the Output file prefix slot on the Create File List interface.  If you use the Output file prefix, the text you enter will be prepended to the output files.  So, for example, there will be a text file named [prefix]_Eval_[name of coding dimension]_[name of input file].txt.  There will also be a file named [prefix]_[name of input file]_OUTPUT.xls.
4. 4. SIDE : Summarization Integrated Development Environment

4.1 Basic definition / About

SIDE, the Summarization Integrated Development Environment, was developed as an infrastructure for facilitating the construction of reporting interfaces that support group learning facilitators in the task of getting a quick sense of the quality and effectiveness of a collaborative learning interaction. In the previous section we discussed how models built with TagHelper tools can be used to construct a “map” of an interaction as it is in progress in order to be able to flag key events that indicate a need for triggering various instructional interventions.  However, rather than use the automatic analysis to trigger automatic interventions, it might be more desirable to have a human facilitator or instructor in the loop, to receive notifications about the status of ongoing group work or past group work, and to use human judgment to make the final decision about when and how to intervene, and ultimately to offer that intervention.

In classrooms, instructors roam around the room, listen to conversations, and jump in at key moments to offer guidance.  In on-line settings, group learning facilitators are responsible for a larger number of groups.  Listening in on conversations involves reading a high volume of text based chat, often paired with data streams in other modalities such as a digital whiteboard.  The challenge is to enable group learning facilitators to quickly get a sense of the collaborative interaction so his resources can be strategically invested.

The SIDE framework offers flexibility in the specification of which conversational behavior to take note of as well as how noted behavior should be reported to instructors, making it a valuable research tool as well as support for instructional practice.

4.2 Example Applications
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Figure 1 Example visualization of argumentation behavior in a course discussion board over a year.
As a scenario, consider a course where students are heavily involved in on-line discussions as part of their participation in the course.  Instructors likely do not have time to keep up with all of the correspondence contributed on the course discussion board.  One such example is an on-line environment for Civics education where students participate in debates over time about bills that they propose in what amounts to a ”virtual legislature”.  Figure 1 displays student posting behavior over the course of an academic year in terms of both the number of posts and the level of argumentation quality of detected automatically in those messages over time.  From this visualization, one observation is that the frequency of student posts increases over the course of the semester.   It is also clear that the proportion of high quality argumentation, indicated in green, does not consistently increase over the course of the semester.  Weeks where the proportion of messages with high quality argumentation is highest seem to be weeks where there is a larger than average frequency of posting, potentially indicative of weeks where there is more intensive debate.  Instructors using a visualization like this would be able to determine which weeks students were not particularly engaged in the discussion.  It would also help the instructor to identify weeks where the argumentation quality is lower than desired in order to offer suggestions or other support to elevate the level of intensity in the discussion in order to provide students with better opportunities to hone their argumentation skills. 

Another similar scenario where reports based on analyses of behavior in a discussion forum can be useful is project based courses where students do a lot of their group work outside of the direct supervision of the instructor.  Insights about the well functioning of student groups can be gleaned from some byproducts of group work, such as the messages left in a groupware environment used to coordinate the group work.  In some of our prior work we have determined that by aggregating the messages posted by a student during a week and extracting basic text features, such as unigrams and bigrams, as described in the TagHelper tools section, machine learning models can make predictions with reasonable accuracy of how the instructor would rate the extent to which students had contributed productively to their group that week (with a correlation coefficient of R=.63 in comparison with instructor assigned productivity grades).  Such an interface could display trends in student participation over time to aid instructors in identifying students who may need more attention and prodding to intensify their contribution to their respective groups.

Visualizations are not the only type of summary that may be useful to instructors, however.  With respect to the example in Figure 1, rather than knowing what proportion of messages exhibited high levels of argumentation quality, the instructor may want to see particularly good examples of argumentation quality to draw attention to as an example for struggling students.  Alternatively, an instructor may want to glean a list of questions posed by students during a collaborative learning discussion in order to gauge which topics are confusing for students.  Another possibility would be to monitor discussions related to negotiations over issues, such as design discussions where trade-offs such as power output versus environmental friendliness are being made with respect to the design of a power plant.  In that case, it might be interesting to classify conversational contributions as indicating a bias towards environmental friendliness, or alternatively high power output, so that it is possible to display how preferences ebb and flow in the course of the discussion.

4.3 Installation / Setup

· Check my java virtual machine (jvm) version
SIDE 2.0 requires java 1.6 or higher
For a PC

· open console ('Start' > 'run' > type 'cmd' )

· type "java -version" (double quote exclusive)

· if it shows message like … java version "1.6.* …" …, you have jvm 1.6

For a MAC

java 1.6 requires MAC OS 10.5 or higher and 64-bit dual processor
· open terminal (search it using search (magnifier) icon on the top right corner)

· type  "/System/Library/Frameworks/JavaVM.framework/Versions/1.6.0/Home/bin/java -version" (double quote exclusive)

· if it shows message li ke … java version "1.6.* …" …, you have jvm 1.6

· Install jvm 1.6

skip this step if you already have java 1.6
For a PC / UNIX

Follow this link to download : http://java.sun.com/javase/downloads
For a MAC 

option 1: use 'software update'

option 2: jre 6 (by 2009/07)

install 'jre 6' with highest update version for your machine

· Starting SIDE 2.0

Download SIDE 2.0 from http://lti-side.wikidot.com/side-2-0:side-2-0 

For a PC: save it anywhere you want, but remember the folder path

For a MAC: download it at the folder 'Desktop'

· unzip SIDE 2.0 

· from now on, [name of the folder of SIDE] is the folder that SIDE got unzipped.) 
For a PC (IBM)

· Go to folder, 'program/SIDE' from the folder you installed SIDE.

· Execute “run.bat” file at 'program/side' folder. Double-click on SIDE.jar file will also run the program, but it will eventually cause memory deficiency problem while training your machine learning algorithm. The following is the first screen you will see when you run SIDE.

For a MAC

· open terminal (search it using search (magnifier) icon on the top right corner)

· In terminal, move to 'program/SIDE' folder from the folder where you installed SIDE 

· type in "cd /Desktop/[name of the folder of SIDE]/program/SIDE" (double quote exclusive)

· copy content of [name of the folder of SIDE]/program/SIDE/mac_run.sh

· paste in terminal and hit enter

Fortunately, once SIDE has been extracted, installing and running it is very straightforward.

· Go to folder, 'program/SIDE'.

·  Execute “run.bat” file. 
· Note that double-clicking on SIDE.jar file will also run the program, but it will eventually cause a memory deficiency problem at certain stages of operation.  So it is better to launch it using run.bat.

The following is the first screen you will see when you run SIDE.
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Figure 2 SIDE main menu panel.  See Section 4.4 for instruction about how to use these 4 buttons.
4.4 Basic Instructions

Before stepping through how to use the SIDE GUI, it may be helpful to think at a high level about the process.  First note that when using SIDE, we think in terms of producing summaries or reports about documents.  Often the term “document” conjures up images of newspaper articles or reports, but even discussions or individual contributions to discussions can be documents.  For our purposes, typical documents will be those that come up in instructional contexts such as answers to open response questions, logs from on-line discussions, email messages from students, posts to course discussion boards, and so forth.  

SIDE was designed with the idea that documents, whether they are logs of chat discussions, sets of posts to a discussion board, or notes taken in a course, can be considered relatively unstructured.  Nevertheless, when one thinks about their interpretation of a document, or how they would use the information found within a document, then a structure emerges.  For example, an argument written in a paper often begins with a thesis statement, followed by supporting points, and finally a conclusion.  A reader can identify this structure even if there is nothing in the layout of the text that indicates that certain sentences within the argument have a different status from the others.  Subtle cues in the language can be used to identify those distinct roles that sentences might play.  Thus, machine learning models can be used to assign status tags to individual sentences and thus impose a structure on what initially looked at the surface to be unstructured.  That structure can then be used in retrieving certain portions of the argument that might be of interest.  For example, perhaps only the supporting arguments are of interest.  It would not be possible to summarize the argument by pulling out those portions without first imposing the structure on the text that distinguishes between those three types of sentences.

Conceptually, then, the use of SIDE has two main parts.  The first part is to construct filters that can impose structure on the texts that are to be summarized, and finally is constructing specifications of summaries that refer to that structure and extract subsets of text or display visualizations of that structure.

To train the system and create a model, the user has to define a filter. Filters are trained using machine learning technology such as was discussed in depth in Section 3 in connection with TagHelper tools.  In fact, one could consider SIDE to be an environment “built on top of” TagHelper tools.  Thus, before proceeding, interested readers should become familiar with the material in Section 3 before proceeding here.

Once the reader has grasped the concepts in the TagHelper tools section, then it is not much of a stretch to consider that defining a filter has 4 steps – creating annotated files with user-defined annotations, choosing feature sets to train (unigrams, bigrams etc), choosing evaluation metrics (Word Token Counter, TF-IDF) and choosing a classifier to train the system.  Without the foundation of concepts from Section 3, this set of notions will likely sound very foreign.  

The arrangement of the buttons on the Side main menu panel introduced above in Section 4.3 follows a logical process of using SIDE.  The first button allows the user to input files either in text form or .csv form and convert them to the SIDE internal format, referred to as UIMA.  The Segmentation & Annotation interface enables users to define coding schemes that can be applied either by hand, using the Annotation interface, to place a structure on a document, or automatically, with a filter that can be defined using the Feature Table and Model Building interface.  Note that before you can train a model, you need to have some annotated data to train the model with, which you can produce from unannotated date with the Segmentation & Annotation interface.  Alternatively, just like with TagHelper tools, you can load already annotated data from .csv files.  Structured files that result from annotation, either by hand or automatically can be summarized.  The Summary Panel allows the user to define how a summary can be built by specifying filters that will be used to apply structure to a document first, and then either specifying how visualizations can display patterns of annotations, or annotations can be used to find desired portions of a document.

For a running example, we will use two files you will find in the SIDE folder you have been given, namely UnlabeledExamples.csv and QualitativePhysics.csv.  This data comes from a project related to qualitative physics tutoring systems you can find described in the following two research articles (if you’re really interested!!):

Rose, C. P., & VanLehn, K. (2005). An Evaluation of a Hybrid Language Understanding Approach for Robust Selection of Tutoring Goals, International Journal of AI in Education 15(4). (http://www.cs.cmu.edu/~cprose/pubweb/IJAIED315Rosev4.pdf)

VanLehn, K., Graesser, A., Jackson, G. T., Jordan, P., Olney, A., Rose, C. P., (2007). Natural Language Tutoring: A comparison of human tutors, computer tutors, and text. Cognitive Science, 31 (1), pp3-52. (http://www.cs.cmu.edu/~cprose/pubweb/WHY-Cogsci.pdf)

QualitativePhysics.csv contains example statements made by students, which have been annotated with physics principles related to the scenarios explored on that project, or labeled as “nothing” in the case that the statement was not a correct reference to any principle students were expected to articulate.  UnlabeledExamples.csv contains a sampling of explanations collected in the same context but not annotated in this way yet.  In this scenario, imagine you are an instructor who is responsible for examining all of the explanations submitted by students through an on-line qualitative physics portal.  You’re responsibility is to identify statements by students that are not quite correct so that you can contact those students, assuming they need more of your attention than other students who managed to submit fully correct explanations.  You could do this job by reading through all the comments submitted by students.  But with SIDE, you could produce a “summarization system” that would pull these statements out of the set submitted by students so you could spend less time finding those.

Step 1: Converting Files to UIMA
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Figure 3 Convert to UIMA Interface, which is used to load files either in .csv or text format and then convert them to UIMA for use in SIDE.

Files can be loaded into SIDE either in .csv or text format.  But almost everything SIDE does requires the data to be in a format called UIMA.  So when you load the files, they are converted into UIMA format.  This is done through the Convert to UIMA interface.  As displayed in Figure XX, you must select the format of the files you are loading using the pulldown menu you see at the top of the interface.  If the column of data in the files that contains the text field is labeled as anything other than “text”, you should indicate this at the bottom where it says “name of text column”.  Finally, click on the Convert files button.  You should then see a message confirming that the files have successfully been converted to UIMA format.

Step 2: Setting Up Annotated Files for Training a Model
Figure XX shows the interface for training a model for segmenting and annotating unannotated files with SIDE.  You’ll see it has two main tabs, namely the Feature Table tab (described more in detail in Step 3 below) and the Model Building tab (described in Step 4 below).

If we assume that the user has input already annotated files in Step 1, then the next step in the process of using SIDE is to train filters that can “impose” a structure on the relatively unstructured conversational data as a foundation for the report that will be generated.  Steps 2-4 will elaborate upon this process.  
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Figure 4 Segmentation and Annotation interface.  Notice that this interface has two panels, corresponding to the two main aspects of training a machine learning model for processing text, namely designing the feature space and training the model using a machine learning algorithm.

The first step is to load UIMA files that have been annotated into the Feature Table and Model Building interface.  Filters are “trained” from data that has been segmented and annotated.  Files are loaded into this interface using the Add button at the top of the left side panel on the Feature Table tab.  This will bring up a File Finder interface pointing to the directory where xmi files are found, which are UIMA files converted from files input to the Convert to UIMA interface.
In our initial example, we will work with a dataset that has already been segmented and  annotated with a category prior to being loaded into SIDE, which is found in QualitativePhysics.csv.  Once this file has been converted to UIMA, it will already be annotated.  This is one way of using SIDE.  Another way is to load a pre-segmented file or use automatic segmentation, and then to annotate those segments using the annotation interface inside the SIDE GUI environment.  We will explore that option later after Step XX when we begin to talk about the Segmentation and Annotation interface.

For now, once you have loaded the xmi version of QualitativePhysics.csv, be sure that you select CLASS in the pulldown menu labeled Annotation.  This tells SIDE that it’s the annotations that had been labeled as CLASS in the .csv file that the model will be trained to predict.

Step 3: Setting Up a Feature Space for Training
In many ways, the Feature Table and Model Building interface mirrors the functionality included in TagHelper tools.  Step 4 of the TagHelper tools instructions elaborates in great detail about the meaning of the options for feature space design.  As discussed there, the simplest feature space is set up with one binary attribute per unique word in the corpus such that if that word occurs in a text, its corresponding feature will get a value of 1, otherwise it will get a value of 0. Other features may be added, or the baseline features may be modified or paired down, in order to bias the algorithms to learn rules that are more valid or conceptually more closely related to the definitions of the target categories.
Figure XX shows what will happen if you click on the BasicFeatureExtractor option.  Once you have selected this option, you can then right click on that option to get the list of corresponding feature space options, which mirror most of the options found in TagHelper tools and described in connection with Step 4 of the TagHelper tools instructions.  What you see displayed in Figure XX is the simplest feature space configuration.  We recommend that you start with this.  But you can easily experiment with different options by selecting the different options.  In the next step, when you actually use a machine learning algorithm to train a model, you will have the opportunity to see whether the algorithm is able to learn an effective model with this feature space design.  If you are not happy with that performance, one of your options for improving the performance will be to experiment with different feature space options.
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Figure 5 If you click on the BasicFeatureExtractor option, you can then right click to get the list of corresponding feature space options, which mirror most of the options found in TagHelper tools and described in connection with Step 4 of the TagHelper tools instructions.

Once you have selected your feature space options, you should enter a name for the feature space design in the slot labeled as “new feature table name” and then click on the “create feature table” button.  The name of the feature space you just defined should then appear in the feature table list at the bottom of the left side portion of the tab.
Step 4: Training a Model
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Figure 6 The Machine Learning tab allows you to train models using machine learning algorithms to predict labels from your annotations from patterns it finds in the feature space you defined using the Feature Table tab.
Figure 6 shows the interface for setting up the machine learning model to learn how to predict your annotations.  This model will then be used to assign labels to unlabeled texts either on the Segmentation & Annotation interface or in the process of generating a summary on the Summary Panel.
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Figure 7 

As you can see in Figure 7, SIDE offers all of the same options for machine learning that TagHelper tools does, so please refer to the TagHelper documentation for further instruction on making that selection.

Next, refer back to Figure 6.  Please select a feature table from the pulldown menu underneath the machine learning algorithm selection menu.  You should see a list there of all the feature tables you have created.  Next select a segmenter.  If the file you have input is already segmented, select Above segmentation.  Finally click the Train Model button.  It will take a little while for the training to complete.  When it does, some status messages should appear in the panel on the right.  To see how well the performance was of the trained classifier, select Summary from the pulldown menu at the top right of the interface.  You should see something like what is displayed in Figure 8.
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Figure 8

Step 5: Defining a Text Summary

At this point, you then have a filter that can be used to segment and annotate a new file.  Once a file has been segmented and annotated, that imposed structure can be used in the process of generating a summary so that you can retrieve just those parts of the document that are relevant for the summary you want.  In our case, we want to extract all of the segments that are labeled as Nothing.
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Figure 8 Defining selection criteria

Figure 8 displays the interface for defining a recipe for summarization.  The first step is to define the selection criteria, which will be used to extract a subset of segments from the text.  The selection criteria is specified in terms of annotations that have been defined.  If you refer to a filter in the selection criteria, that filter will be applied to the text.  Then the conditions placed on that filter will be applied.  What that means is that you can indicate that a subset of the annotations that can be applied to the filter indicate that the corresponding segments should be selected.  In our case, we want to apply the filter defined using the annotated data from the ConceptualPhysics.csv file, and then select all of the segments it labels as Nothing.  Figure 9 shows how this selection is made.  Note also that using a combination of And, Or, and Is from the Expression Builder interface, you can create arbitrarily complex selection criteria involving multiple filters.
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Figure 9 Selecting a subset of annotations
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Figure 9 Loading unannotated data

Next you should load some unannotated data to summarize.  You do this by clicking on the Add button at the top of the summary tab on the Summary Panel.  Then select the file with the unannotated data.
[image: image76.jpg]Test

summary | text recipe

S

annotation:

resuits:

5 Testing(20090711_145904) 7 X

native

£ summary recipe:

‘Thus *COMMAT when the objects become separats “OPARENT the man releases the keys "CPAREN®
“COMMAT the downward force on each object s not the same *COMMAT butis instead proportional to its mass
“PERIOD”

Testing(20090711_140107)

summary name: [Testing

create summary object

B summary:

Testing(20090711_145904)

summarizel

visualization:

plugin.samplevisalization. TimeSeriesVisualizationPlugin

visualize

Therefore *COMMAT their initial velocity is the same *PERIOD®

S0 the egg remains the same harizontal velocity as before “PERIOD®

ithits the ground





Figure 10 a completed text summary
The final step is to click on the summarize button.  The corresponding text summary will appear in the area on the right side of the interface.
Step 6: Defining a Visual Summary
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Figure 11 Building a visual summary

Apart from text summaries, it’s also possible to use SIDE to build visual summaries.  From the Visualization pulldown menu, select the type of summary you want to generate.  For now, select Pie Chart.  Then click the Visualize button.  A pie chart interface should then appear on the right of the interface.  You can then select which annotation to use from the Target Columns pulldown menu.
Step 7: Using the Segmentation and Annotation Interface
The Segmentation and Annotation interface allows you to define annotation schemes, do annotation by hand, and apply trained models to annotate texts automatically.  To try this out, first load the UnlabeledData.csv.xmi file into the Segmentation and Annotation interface using the load file button.
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Select CLASS from the pulldown menu underneath the load file button.  Then click on the annotate using model button.  Now you’ll see the full set of labels defined to the left and annotated data to the right.  If you right click in a segment, you can change the annotation by making a different selection from the pulldown menu, which should list all of the annotation labels defined in the list on the left.
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Essential Information : 





CTAT requires the J2SE Java Runtime Environment (JRE), version 1.5 or later. Mac OS X ships with Java installed. For more information about Java on OS X.





A CTAT tutor may be created using either of flash or Java





Flash 8 IDE or greater is required to develop new tutor interfaces with Flash. Flash 8 IDE is recommended.


NetBeans IDE 4.1 or greater and the Java 2 Standard Edition SDK v 1.5 (J2SE SDK) are required to develop new tutor interfaces in Java. NetBeans IDE 5 is recommended.











